NOTE: The WFDE Prediction Program is part of the Garmin Trainer and Route Planning software programs. The required software and instructions are available via the Garmin website at www.garmin.com.

NOTE: The WFDE Prediction Program requires an internet connection to provide access to current almanac, GEO almanac, and configuration files.

NOTE: These instructions assume the user has experience operating the G1000 with GIA 63W, the GNS480/CNX80, or the applicable GNS 400W/500W or GTN 6XX/7XX Series Unit and is familiar with the operation of RAIM and FDE.

Table of Contents

1 OVERVIEW .......................................................................................................................................................................................... 2
  1.1 Fault Detection and Exclusion (FDE) ............................................................................................................................................ 2
  1.2 Determining When a WFDE Prediction is Required ...................................................................................................................... 2
  1.3 Determining When a WFDE Prediction is Required For GTN Products .......................................................................................... 4

2 IDENTIFYING GPS SOFTWARE VERSION ............................................................................................................................................. 5
  2.1 GNS 400W/500W Series Products ................................................................................................................................................ 5
  2.2 GNS 480/CNX80 ........................................................................................................................................................................... 5
  2.3 G1000 with GIA 63W ....................................................................................................................................................................... 6
  2.4 GTN 6XX/7XX ............................................................................................................................................................................. 6

3 RUNNING THE FDE PREDICTION PROGRAM ....................................................................................................................................... 7

4 INTERPRETING THE FDE PREDICTION RESULTS ............................................................................................................................. 14

5 UPDATING/CHANGING ALMANAC AND CONFIGURATION FILES .................................................................................................... 16
  5.1 Almanac, GEO Almanac, and Configuration Files ...................................................................................................................... 16
  5.2 Changing the Configuration File ................................................................................................................................................. 17

6 PRINTING ........................................................................................................................................................................................... 18
  6.1 Printing the Prediction Results .................................................................................................................................................. 18
1 OVERVIEW

The following sections provide an overview of the WFDE Prediction Program and guidelines for when it should be used. Section 1.2 provides a comprehensive set of guidelines for when a WFDE prediction is required that is applicable to any installation of a Garmin WAAS enabled unit. Section 1.3 provides specific guidance for GTN 6XX/7XX installations.

1.1 FAULT DETECTION AND EXCLUSION (FDE)

The GARMIN G1000 with GIA 63W, the GNS480/CNX80, and the GNS 400W/500W series products incorporate Fault Detection and Exclusion (FDE) features, satisfying the requirements of TSO-C145a/C146a and “GPS Oceanic/Remote Navigation” per FAA AC 20-138A Appendix 1. The GTN 6XX/7XX series products incorporate Fault Detection and Exclusion (FDE) features, satisfying the requirements of TSO-C146c and “GPS Oceanic/Remote Navigation” per FAA AC 20-138A Appendix 1. For the purposes of this document, WAAS FDE Prediction, FDE Prediction, and WFDE Prediction may be used interchangeably.

FDE consists of two distinct parts: fault detection and fault exclusion. Fault detection (RAIM) detects the presence of an unacceptably large pseudorange error (and presumably, position error) for a given mode of flight or a satellite failure which can affect navigation. Fault detection is synonymous with RAIM (Receiver Autonomous Integrity Monitoring). Upon the detection of a fault, fault exclusion follows and excludes the source of the unacceptably large pseudorange error, thereby allowing navigation to return to normal performance without an interruption in service. FDE functionality is provided for oceanic, en route, terminal, and non-precision approach phases of flight. The FDE functionality adheres to the missed alert probability, false alert probability, and failed exclusion probability specified by TSO-C145a/C146a and TSO-C145c/C146c.

The WFDE Prediction Program is used to predict the availability of RAIM/FDE for a specified flight plan. This program allows the pilot to specify the planned departure date/time, route type, ground speed, ground speed variation, and maximum allowable outage. When provided through NOTAM or other sources, GPS satellites with known failures can be excluded through the program’s setup function.

NOTE: WAAS is one of several systems generically known as SBAS (Satellite Based Augmentation System). Garmin WAAS certified products are designed to work with any TSO-C145a/C146a or TSO-C145c/C146c compliant SBAS system.

The WFDE Prediction Program is designed for use with TSO-C145a/C146a and TSO-C145c/C146c approved WAAS-(Wide Area Augmentation System) certified Garmin products. These products include:

- GPS 400W, GNC 420W, GNC 420AW, GNS 430W, GNS 430AW
- GPS 500W, GPS 500W TAWS, GNS 530W, GNS 530W TAWS, GNS 530AW, GNS 530AW TAWS
- GNS 480, CNX80
- G1000 with GIA 63W
- GTN 625, GTN 635, GTN 650, GTN 725, and GTN 750
1.2 DETERMINING WHEN A WFDE PREDICTION IS REQUIRED

The WFDE Prediction Program determines whether the GPS constellation is robust enough to provide a navigation solution for the specified route of flight. As required (dependent upon type of flight plan, GPS Software (SW) version, and GPS antenna), prior to departure the operator must use the WFDE Prediction Program supplied with the applicable trainer or route planning software to demonstrate that there are no outages in the capability to navigate on the specified route of flight (Table 1).

NOTE: If the route of flight requires an alternate airport, multiple predictions may be required (one for the primary and one for the alternate) to verify RAIM and/or WAAS satellite availability at the primary and the alternate approach.

A WFDE Prediction is required for the following instances (see also Table 1):

- For all Garmin WAAS enabled units (regardless of the GPS software version or antenna model): an FDE prediction is required for operations where the route requires Class II Navigation (e.g. Oceanic/Remote operation) and GPS is to be the primary source of navigation per FAA AC 20-138A Appendix 1. The Oceanic/Remote flight phase occurs when the flight plan will place the aircraft more than 200 nautical miles from the nearest airport. All operators using a Garmin WAAS-certified unit as primary means of navigation in oceanic/remote areas under FAR parts 91, 121, 125, and 135 must utilize the WFDE Prediction Program prior to conducting a flight in these areas.

- For all Garmin WAAS enabled units (regardless of the GPS software version or antenna model): a RAIM prediction is required for operations in areas where SBAS coverage is not available.

- For Garmin WAAS enabled units using an unapproved* GPS antenna (regardless of the GPS software version): a RAIM prediction is required for all flight operations in accordance with the National Aviation Authority guidelines for TSO-C129a equipment. Examples of such operations include navigation of U.S. Area Navigation (RNAV) routes, Standard Instrument Departures (SID), or Standard Terminal Arrival Routes (STARs) per FAA AC 90-100A “U.S. Terminal and En Route Area Navigation (RNAV) Operations”.

- For Garmin WAAS enabled units using an unapproved* GPS antenna (regardless of the GPS software version): an operational limitation in the form of a WAAS satellite visibility prediction is required for all LNAV/VNAV, LP, or LPV approaches.

- For Garmin WAAS enabled units with GPS Software v2.XX or earlier (regardless of GPS antenna model): an operational limitation in the form of a WAAS satellite visibility prediction is required for all LNAV/VNAV, LP, or LPV approaches.

A WFDE Prediction is not required for the following instances (see also Table 1):

- For Garmin WAAS enabled units with GPS Software v3.XX or later and using an approved* GPS antenna: a RAIM prediction is not required when operating in areas where SBAS coverage is available.

- For Garmin WAAS enabled units with GPS Software v3.XX or later and using an approved* GPS antenna: a WAAS satellite visibility prediction is not required for LNAV/VNAV, LP, or LPV approaches.

<table>
<thead>
<tr>
<th>Route Type</th>
<th>GPS SW Version</th>
<th>Antenna Type*</th>
<th>WFDE Prediction Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oceanic/Remote</td>
<td>2.XX or earlier</td>
<td>Approved/Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>Enroute/Terminal</td>
<td>2.XX or earlier</td>
<td>Approved/Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>LNAV/VNAV, LP, or LPV Approach</td>
<td>2.XX or earlier</td>
<td>Approved/Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>Oceanic/Remote</td>
<td>3.XX or later</td>
<td>Approved/Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>Enroute/Terminal</td>
<td>3.XX or later</td>
<td>Approved</td>
<td>NO</td>
</tr>
<tr>
<td>Enroute/Terminal</td>
<td>3.XX or later</td>
<td>Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>LNAV/VNAV, LP, or LPV Approach</td>
<td>3.XX or later</td>
<td>Approved</td>
<td>NO</td>
</tr>
<tr>
<td>LNAV/VNAV, LP, or LPV Approach</td>
<td>3.XX or later</td>
<td>Unapproved</td>
<td>YES</td>
</tr>
<tr>
<td>Operations outside SBAS coverage</td>
<td>All versions</td>
<td>Approved/Unapproved</td>
<td>YES</td>
</tr>
</tbody>
</table>

Table 1
* Approved refers to antennas listed in the applicable Installation Manual (Table 2) that allow the Garmin WAAS enabled unit with GPS software v3.XX or later to meet the TSO-C145a/C146a or TSO-C145c/C146c requirements without requiring the operational limitations specified in the applicable Installation Manual. Unapproved refers to antennas listed in the applicable Installation Manual (Table 2) that allow the Garmin WAAS enabled unit (regardless of GPS Software version) to meet the TSO-C145a/C146a or TSO-C145c/C146c requirements with the operational limitations specified in the applicable Installation Manual.

<table>
<thead>
<tr>
<th>Document Name</th>
<th>Document Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIA 63/GIA 63W Installation Manual</td>
<td>190-00303-05</td>
</tr>
<tr>
<td>400W Series Installation Manual</td>
<td>190-00356-02</td>
</tr>
<tr>
<td>500W Series Installation Manual</td>
<td>190-00357-02</td>
</tr>
<tr>
<td>GNS 480 (CNX80) Installation Manual</td>
<td>560-0982-01</td>
</tr>
<tr>
<td>GTN 6XX/7XX AML STC Installation Manual</td>
<td>190-01007-A3</td>
</tr>
<tr>
<td>GTN 625/635/650 TSO Installation Manual</td>
<td>190-01004-02</td>
</tr>
<tr>
<td>GTN 725/750 TSO Installation Manual</td>
<td>190-01007-02</td>
</tr>
</tbody>
</table>

Table 2

1.3 **DETERMINING WHEN A WFDE PREDICTION IS REQUIRED FOR GTN PRODUCTS**

For the GTN 6XX/7XX series, a WFDE Prediction is only required in the following circumstances:

- An FDE prediction is required for operations where the route requires Class II Navigation (e.g. Oceanic/Remote operation) and GPS is to be the primary source of navigation per FAA AC 20-138A Appendix 1.

- A RAIM prediction is required for operations in areas where SBAS coverage is not available.
2 IDENTIFYING GPS SOFTWARE VERSION

The GPS software version used in the Garmin WAAS enabled unit must be determined prior to performing the WFDE prediction. The GPS SW version may be a factor in determining if a WFDE prediction is required.

2.1 GNS 400W/500W SERIES PRODUCTS

Identifying GPS Software Version of a GNS 400W/500W Series product:

1) Turn the COM power/volume knob clockwise to turn the unit on.
2) The Main and GPS software version page (Figure 1) appears briefly. Take note of the GPS SW Version.

2.2 GNS 480/CNX80

Identifying GPS Software Version of a GNS 480 or CNX80:

1) Push the PWR/VOL knob to turn the unit on.
2) Press the FN key and then the SYS key to reach the System functions.
3) Press the VERS function smart key to display the Software Versions Page (Figure 2), note the GPS Engine Software Version.
2.3 G1000 WITH GIA 63W

Identifying GPS Software Version of a G1000 with a GIA 63W:

1) With the G1000 in normal mode, use the FMS Knob on the MFD to select the AUX - System Status Page (Figure 3).
2) Note the GPS Software Version.

2.4 GTN 6XX/7XX

Identifying GPS Software Version of a GTN 6XX/7XX:

1) Apply power to turn the unit on.
2) From the Home page, touch the System key to reach the System functions.
3) Touch the System Status key.
4) Note the GPS/WAAS Software Version.
3  RUNNING THE FDE PREDICTION PROGRAM

Trainer and route planning software for WAAS-certified Garmin products include a WFDE Prediction Program to meet the FDE requirements for GPS as a primary means of navigation for Oceanic/Remote operations (reference FAA AC 20-138A Appendix 1).

To use the WFDE Prediction Program, begin by entering the intended flight plan into the applicable Garmin Trainer software or the Garmin Route Planning software. The WFDE Prediction Program uses this information to analyze satellite coverage along the intended route of flight.

NOTE: A flight plan must be created and activated (using the applicable Trainer or Route Planning software) prior to running the WFDE Prediction Program. The WFDE Prediction Program only works with the currently active flight plan. Follow the software instructions to create and activate a flight plan. Software and instructions are available via the Garmin website at www.garmin.com.

Running the WFDE Prediction Program:

1) Make sure the applicable Trainer or Route Planning software is running. If using a Trainer program, make sure the simulated unit is on, and the desired flight plan is active.

2) If using a Trainer program, select the “Options” menu (Figure 5) in the upper left corner, and select “WFDE Prediction Program” (G1000 Trainer and GTN Trainer), “Fde Prediction Program” (GNS 400W/500W Trainer), or

3) If using the Garmin Route Planning Software, click on the “Start Prediction” button after setting up the route (Figure 5).

NOTE: If the WFDE Prediction Program has not been used previously, or has not been run recently, a series of pop-up messages (Figure 6) may precede the WFDE Prediction Program window. Follow the on-screen instructions to download new data from the internet. The download time is normally very short (nearly instantaneous), but may vary with internet connection. See the “Updating/Changing the Almanac and Configuration Files” section of this document for details.
4) The WFDE Prediction Program window appears (Figure 7) listing the flight plan waypoints, selected antenna, and the current date/time as the departure time. It is important to verify that the displayed route is correct before proceeding with the prediction. Reference Table 3, and verify the correct Garmin part number (006-A0154-0X) appears at the top of the screen for the applicable product. If the part number is incorrect, see Section 5 of this document.

**Figure 6 Possible Update Messages**

**Figure 7 WFDE Prediction Window**

**NOTE:** The “Other Garmin series” listing in Table 3 should be selected when using a system with a TSO-C146A compliant WAAS antenna and software (see Section 1.2).
5) Make sure that the selected antenna and software version option matches the antenna and GPS software installed on the aircraft that will fly the flight plan. To change the selected antenna and software version option, click the down arrow next to the “Antenna” field. A pull-down list appears listing the available antenna and software version configuration options. Table 4 describes the available antenna and software version configuration options available in the “Antenna” field pull-down list.

### Table 3

<table>
<thead>
<tr>
<th>Garmin Part Number</th>
<th>Applicable Product</th>
</tr>
</thead>
<tbody>
<tr>
<td>006-A0154-01</td>
<td>G1000 with GIA 63W</td>
</tr>
<tr>
<td>006-A0154-02</td>
<td>GNS 480/CNX80</td>
</tr>
<tr>
<td>006-A0154-03</td>
<td>GNS 400W/500W</td>
</tr>
<tr>
<td>006-A0154-04</td>
<td>Other Garmin Series</td>
</tr>
<tr>
<td>006-A0154-05</td>
<td>GTN 6XX/7XX Series</td>
</tr>
</tbody>
</table>

**NOTE:** The installed antenna model may be listed in the applicable AFMS.

### Table 4

<table>
<thead>
<tr>
<th>Antenna and Software Version Option as Displayed in “Selected Antenna” Pull-down List</th>
<th>Option Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GPS SW &gt;= 3.XX</td>
<td>This option should be selected when the installed GPS software version is 3.XX or later and the installed antenna is one of the Garmin approved antennas that result in a fully compliant WAAS system capable of being operated without limitation. See the installation manual for your Garmin system for the list of approved compliant antennas.</td>
</tr>
<tr>
<td>GPS SW &gt;= 3.XX &amp; GA56W</td>
<td>This option should be selected when the installed GPS software version is 3.XX or later and the installed antenna is the Garmin GA56W.</td>
</tr>
<tr>
<td>GPS SW &gt;= 3.XX &amp; GA57</td>
<td>This option should be selected when the installed GPS software version is 3.XX or later and the installed antenna is the Garmin GA57.</td>
</tr>
<tr>
<td>A-33 (575-9/590-1104) A-34 (575-93/590-1112) GA35 (013-00235-00) GA36 (013-00244-00) GA37 (013-00245-00) GA56A (011-01154-00) GA56W(011-01111-00) GA57 (011-01032-00) CI2580-200 CI2580-410 CI2728-200 CI2728-410 CI428-200 CI428-410 Most Conservative</td>
<td>One of these options should be selected when the installed GPS software version is less than 3.0 and the installed antenna matches the antenna displayed in the “Selected Antenna” pull-down list.</td>
</tr>
<tr>
<td>CI2580-200 CI2580-410 CI2728-200 CI2728-410 CI428-200 CI428-410 Most Conservative</td>
<td>This option should be selected when the configuration of the installed GPS SW version and/or antenna model are not known.</td>
</tr>
</tbody>
</table>
6) To change the departure date, click the down arrow next to the “Date (UTC)” field. A calendar window appears. Click the left or right arrows to select a different month (if desired), then click the desired date.

7) To change the departure time, click the hours, minutes, or seconds fields next to the “Time (UTC)” field. Click the up or down arrows (or type in desired time) to change the displayed time.

8) To change the planned route type, average ground speed, ground speed variation, maximum allowed outage, flight duration, Selective Availability conditions, or to deselect satellites, click the Setup button. A setup window is displayed (Figure 8). Click the field for the desired item, then enter the desired value. Table 5 describes the Flight Setup Window options.

<table>
<thead>
<tr>
<th>Flight Setup Window Options</th>
<th>Option Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Route Type</td>
<td>Oceanic - For Oceanic/Remote only operations</td>
</tr>
<tr>
<td></td>
<td>Enroute/Terminal - For all other operations</td>
</tr>
<tr>
<td>Maximum Allowed Outage (Time)</td>
<td>This field defaults to 5 minutes when Oceanic is the selected route type. This field is set to default and “greyed out” (not selectable) when Enroute/Terminal is the selected route type.</td>
</tr>
<tr>
<td>Ground Speed (Avg)</td>
<td>Enter expected average ground speed for flight.</td>
</tr>
<tr>
<td>Ground Speed Variation</td>
<td>The ground speed variation setting will vary with the selected route type, the default is 100 knots for Oceanic and 10 knots for Enroute/Terminal route types. The program automatically runs multiple predictions for a range of ground speeds based on this setting.</td>
</tr>
<tr>
<td>Flight Duration</td>
<td>This field is calculated from the entered ground speed and route information; or the flight duration can be entered, and the program will calculate the average ground speed.</td>
</tr>
<tr>
<td>Departure Date and Time</td>
<td>Enter date and time (in UTC format) of departure, this info can also be entered into the main screen of this program.</td>
</tr>
<tr>
<td>Selective Availability</td>
<td>Simulates Selective Availability conditions when box is checked (normally left unchecked).</td>
</tr>
<tr>
<td>De-select Satellites</td>
<td>Click on the De-select Satellites button to view the Selected Satellites window, see following instructions.</td>
</tr>
</tbody>
</table>

Table 5

**NOTE:** The maximum allowed outage times for Oceanic flights vary according to the specific route. The pilot must determine the proper allowed outage time to be used for the prediction, based upon the route that is being flown.
9) To deselect satellites from the setup window, click “De-select Satellites,” then clear the box adjacent to any satellite that should not be used in the prediction (Figure 9). WAAS satellites are not listed in the Satellite Selection Window as RAIM and FDE availability are not predicated on the availability of WAAS satellites. However, WAAS satellites are required to conduct LP, LPV, and LNAV/VNAV approaches. Always check for NOTAMs regarding LP, LPV, and LNAV/VNAV outages (in addition to using the Prediction Program) to determine the availability of LP, LPV, and LNAV/VNAV approaches at the destination.

![Figure 8 Flight Setup Window](image-url)

**Figure 8 Flight Setup Window**

**NOTE:** Satellites that are unavailable will be “greyed-out” with no check marks. Satellites with “Poor Health” will default to unchecked status.

![Figure 9 Selected Satellites Window](image-url)

**Figure 9 Selected Satellites Window**
NOTE: To ensure accuracy of results, the almanac data used for the RAIM and FDE predictions must be recent. If the information is out of date, the WFDE Prediction Program will automatically prompt the user to update the almanac data (Figure 10). An internet connection is required to use this feature (see following instructions).

10) To calculate RAIM, FDE availability, and WAAS satellite availability; select the Calculate button from the main WFDE Prediction Program window (Figure 7). A “Calculation is complete” message will appear when the prediction is complete (Figure 11).

11) The GPS/FDE Availability Results screen (Figure 12) appears after clicking the OK button on the “Calculation is complete” message screen. The results can be viewed or printed (see Printing section of this document) for later reference.
**Figure 12  GPS/FDE Availability Results Screen**

Viewing the RAIM and FDE Prediction Results:

1. Select the View menu from the main WFDE Prediction Program window. The results also appear automatically after clicking the **OK** button on the “Calculation is complete” message screen.

2. Select Results. A window will appear showing the calculation results (Figure 12).

3. To print the calculation results, see the Printing section of this document.
4 INTERPRETING THE FDE PREDICTION RESULTS

The GPS/FDE Availability Results screen provides either a “GO” or “STOP” status for the GPS, RAIM, FDE, LNAV RAIM, and LNAV/VNAV & LPV minima availability. A yellow flag is a possible result for an FDE prediction for a non-Oceanic prediction (see Figure 12).

A “GO” status indicates that there are enough satellites available during the flight to meet the requirements of that category. It is possible to have multiple FDE Availability outages during the flight and the status may still be a “GO,” as long as none of the outages exceeds the selected maximum allowable outage.

A “STOP” status is the result of a predicted loss of satellite availability. An FDE Availability or RAIM availability failure occurs when sufficient satellites are not available for a period longer than the maximum allowable outage (as selected in the Flight Setup page and viewed in the Setup Information box on the GPS/FDE Availability Results screen) and will produce a “STOP” status.

A yellow flag indicates an FDE outage in a non-Oceanic (En Route/Terminal) type prediction. Because FDE availability is not required for En Route/Terminal operations the yellow flag is only a caution to the pilot indicating that there may be an FDE outage when flying the flight plan. The selected flight plan may be flown despite the caution flag. A “STOP” status can appear in the FDE outage section only when an Oceanic prediction results in an FDE outage.

More satellites are needed to provide FDE availability than are needed for RAIM. More satellites are needed to provide RAIM availability than are needed for basic GPS availability. A GPS Availability failure occurs when there is the loss of the ability to compute a position. This is expected to be accompanied by a an FDE availability failure and a RAIM availability failure.

- For Oceanic/Remote navigation predictions the displayed result should be “FDE is available for this route.” In the event of a predicted outage, the flight should be delayed, canceled, or re-routed where FDE requirements can be met.
- For U.S. RNAV routes, SIDs, or STARs navigation predictions, the displayed result should be “RAIM is available for this route.” In the event of a predicted outage, the flight should be delayed, canceled, or re-routed where RAIM requirements can be met.
- For an LNAV approach at the arrival waypoint predictions, the displayed result should be “LNAV RAIM is available.” In the event that LNAV RAIM is not available, flight planning should include an approach that is not based on GPS navigation equipment.
- For an LNAV/VNAV, LP, or LPV approach at the arrival waypoint predictions, the displayed result should be “LNAV/ VNAV, LP, & LPV minima may be used for flight planning at the arrival waypoint for the estimated arrival time.” In the event of an “LNAV/VNAV, LP, & LPV minima should not be used for flight planning at the arrival waypoint for the estimated arrival time” result, flight planning should include an approach that has at least LNAV minima (if based on GPS navigation equipment) or an approach that is not based on GPS navigation equipment. The prediction of LNAV/VNAV, LP, and LPV approach availability performed by the WFDE Prediction Program only check for the visibility of WAAS satellites at the arrival waypoint. It does not consider the WAAS service volume or the current state of the WAAS system. Pilots should check NOTAMS for WAAS system outages at their planned arrival.”

NOTE: Since (due to unforeseen circumstances) actual departure times often differ from planned departure times, it is good practice to perform predictions for several possible departure times.
Suggestions to change the result of a failed flight plan prediction:

1) Alter the departure date and time.

2) Alter the route of flight.

3) Verify any deselected satellites. It is possible that some satellites unavailable for a previous prediction are now available.

4) Update the almanac, especially if it is more than three months old.

5) Use the correct antenna selection (if “Most Conservative” was used).

6) For Oceanic/Remote operations, determine the actual maximum allowed outage and use for the prediction (instead of the 5 minute default setting which is generally shorter than the actual allowed outage time).
5  UPDATING/CHANGING ALMANAC AND CONFIGURATION FILES

5.1  ALMANAC, GEO ALMANAC, AND CONFIGURATION FILES

To ensure that each is current, the Almanac, GEO Almanac, and Configuration Files are automatically checked each time the program is started. If the program finds any of these files to be out of date, it will automatically update the file via the internet. A provision has been made to update these files manually, if needed.

Manually Updating the Almanac, GEO Almanac, and Configuration Files:

1) From the main WFDE Prediction Program window, select the Help menu (Figure 14).

2) Select the “Update Almanac,” “Update GEO Almanac,” or “Update Configuration File.” The program automatically searches the internet and downloads the most recent data.

3) A pop-up window appears to confirm that the data has been downloaded. Click the **OK** button to return to the WFDE Prediction Program.

4) The file has been updated.
5.2  CHANGING THE CONFIGURATION FILE

The WFDE Prediction Program may be used with several different Garmin software programs. Each program uses a specific configuration file to run the WFDE Prediction Program. If the user has multiple Garmin programs loaded, the user must verify that the configuration file currently in use is correct for the Garmin product that will be used to navigate the flight plan. Generally speaking, most users will not need to change the configuration file, although a provision has been made to update these files manually, if needed.

Changing the WFDE Configuration File:

1) From the main WFDE Prediction Program window, select the Help menu (Figure 14).
2) Select “Change WFDE Configuration File.”
3) A pop-up window appears. Click the OK button to allow the program to download new configuration files via the internet. When the configuration files have been downloaded, a “Configuration Select” pop-up window appears.
4) Click the down arrow to view the pull-down list of available configuration files (Figure 15). Select the file corresponding to the Garmin product that will be used to navigate the flight plan.

NOTE: The “Other Garmin series (006-D0740-04.ini)” listing on the “Configuration” pull-down menu (Figure 15) should be selected when using a system with a TSO-C146A compliant WAAS antenna and software (see Section 1.2). For the GTN 6XX/7XX Series select “006-D0740-05.ini.”

5) Click the correct file name on the pull-down list, then click the OK button.
6) The configuration has been changed. See Figure 7 and Table 3 to verify the correct part number appears on the WFDE Prediction Program window.
6 PRINTING

6.1 PRINTING THE PREDICTION RESULTS

Use of the “Print” selection on the “File” menu (in the upper left-hand corner) is not recommended, as the complete results of the prediction are not included on the printout. If a printout is desired, use the following steps.

Printing the Prediction Results:

1) From the GPS/FDE Availability Results screen (Figure 16), press ALT+PRINT SCREEN to make a copy of the image.

2) Using another program (such as MS Word®), open the file you want to paste the image into and use the “Paste” command to paste the image into the file.

3) Print the file from the “other” program.

4) Repeat the preceding steps (if desired) from the WFDE Prediction Program screen (Figure 6) to record the Departure Time.

Figure 16 Calculation Complete Screen